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1. About Kernel for Project Server

1.1 Brief about this User Manual 

Welcome to the user manual of Kernel for Project Server, a proficient and appropriate recovery tool for MS 
Project Server. This user manual guides users on successfully operating the software. It is recommended 
that novice as well as experienced users should carefully go through this user manual before using the 
software. A user who is well aware of the software can even use table of contents for finding the particular 
portion of manual. The table of contents enlists all the sections described in this user manual from where 
one can navigate through its different sections. The user manual consists of step-by-step guidelines for 
using Kernel for Project Server. The user manual is intended to guide those users who are using this 
software for the first time such that they can perform flawless recovery from corrupt MDF databases. The 
user manual consists of the following sections for guiding the users: 

Introduction 

User Interface Description 

Install and Uninstall 

Usage Guidelines  

Download, Purchase and Register 

Troubleshooting 

Legal Notices 

1.2 Introduction to Kernel for Project Server 

Kernel for Project Server is an advanced, effective, professional and powerful recovery software that 
restores Project Server database instantly and extracts files and documents from corrupt MS Project 
Server. The software helps project administrators to effectively deal with corruption issues and recover all 
project information such as project resources, tasks, task schedule, custom fields, etc from various project 
workspaces. MDF database may get corrupt and inaccessible due to various reasons such as server 
crash, drive failures, fault in saved database, accidental file deletion, etc. 

The software displays location of recovered files in a list-like structure that can be saved in HTML format. 
The tool offers options for finding appropriate files from the scanned database easily. Using this utility, user 
can connect with the database easily as it offers two connection mediums - SQL Server and UDL file. The 
software offers an easy-to-use, highly interactive, self-descriptive, user-friendly graphical user interface 
such that non-technical users can easily operate it without any technical training. The software is 
embedded with advanced algorithms for performing data recovery from corrupt Microsoft Project Server 
databases. The software is available as a free trial version such that users can evaluate the features, 
functionalities and capabilities of the software before making the actual purchase. 
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1.3 How the software works? 

Kernel for Project Server allows collaborating with different people working in the same project and share 

documents, images, files, etc. with them. It also helps in maintaining additional level of security and data 

integrity. The tool recovers all files and folders from corrupt database and also helps in restoring access to 

live SQL server. The software recovers files that got deleted through logical deletion. The process of 

recovering files from corrupt MDF database is as follows: 

Normally, when a user requests a data, it is processed via MS Project Server and MS SQL Server. 

However, in case of Project Server and MDF corruption, the data becomes inaccessible and the 

request cannot be processed. Kernel for Project Server eliminates the dependency of MS Project 

Server for recovery of data and enables the administrator to extract files and folders from corrupt 

MDF database.  

The software recovers files, documents, and tables from corrupt MDF database through 

establishing connection with that database, which is stored in SQL Server. 

All recovered files are further restored in new database and the database is again configured on MS 

Project Server 

1.4 Salient Features 

Some of the key features of Kernel for Project Server are as follows: 

Accurately recovers files, folders and documents from corrupt Project Server MDF databases. 

Efficiently recovers projects, tasks, task relationships, resources, scheduling, project workspace 
sites, ordinary sites and PWA sites. 

Offers two file recovery modes - Raw and Live SQL Instance for efficiently recovering corrupt MDF 
databases. 

Offers two connection options – Connecting through SQL Server and Connecting through UDL file 
to easily connect with the Project Server database. 

Displays preview of the recovered files such that all files and folders are listed in the bottom pane. 

Allows user to save and restore the recovered files at desired location. The recovered tables and 
files can be copied to a new database that can be further configured at MS Project Server. 

The software provides report creation options for checking recovery degree. The software 
generates a list of path location where the files are situated. The report of extracted files and 
documents can be saved in HTML format. 

Maintains data integrity and security. 

Rebuilds the database and uploads it again to Project Server. 
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Performs database recovery in case MDF database got corrupt or when MS Project Server is down. 

Available as free evaluation version such that user can analyze the features and capabilities of the 
software. 

Supports MS Project Server 2010, 2007, 2003, 2002 and MS Project Central (2000). 

Supports MS SQL Server 2000, 2005, 2008 and 2008 R2. 

Offers an easy-to-use, simple, self-descriptive, attractive graphical user interface. No technical skills 
required for operating the software. 

Offers round-the-clock technical support. 

1.5 System Requirements 

Your computer system must have the appropriate configuration before installing and running Kernel for 
Project Server. Following are the minimum system requirements that a system should possess for 
successfully installing the Kernel for Project Server software.  

Basic System Requirements 

Pentium Class Processor 

Minimum 1 GB RAM (2 GB Recommended) 

10 MB of free Disk Space for software installation 

Enough disk space to save recovered data 

Supported Platforms 

Windows 2000 

Windows XP 

Windows Server 2003 

Windows Vista 

Windows Server 2003 - 64 Bits 

Windows Server 2008 Enterprise 
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Windows Server 2008 Enterprise - 64 Bits 

Windows 7 Ultimate 

Windows 7 Ultimate - 64 Bits 

Windows 8 

Supported MS SQL Servers 

MS SQL Server 2000 

MS SQL Server 2005 

MS SQL Server 2008 

MS SQL Server 2008 R2 

MS SQL Server 2012 

Supported Project Server: 

MS Project Server 2010 

MS Project Server 2007 

MS Project Server 2003 

MS Project Server 2002 

MS Project Central (2000) 
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2. Getting started with the User Interface

2.1 Welcome Screen of the Software 

Kernel for Project Server offers user-friendly, attractive graphical user interface. When the software is 
launched, “Select Project Server Database Source” pop-up window appears by default. The software 
offers two options for selecting Project Server Database source - Raw File and Live SQL Instance. 

Figure 2.1: Welcome Screen of Kernel for Project Server 
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2.2 Menu Bar 

      The Menu bar of Kernel for Project Server comprises four menus that are further divided into several menu 
items for performing essential tasks. The four menus are: 

File Menu 

View Menu 

Tools Menu 

Help Menu 

File Menu 

File menu of Kernel for Project Server appears, as shown in the following figure: 

Figure 2.2: File Menu 

The following table enlists the options available in the File menu: 

Option Description 

Open Opens the Database Source Selection window 

Save Saves files, folders and database objects 

Exit Exits from the application 

View Menu 

View menu of Kernel for Project Server appears, as shown in the following figure: 

Figure 2.3: View Menu 
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The following table enlists the option available in the View menu: 

Option Description 

Standard Displays the standard view (without Document 
List and Document Viewer sections) 

Document Viewer Displays and hides Document Viewer section 

Document List Displays and hides Document List section 

Customize… Displays customized view 

Tools Menu 

Tools menu of Kernel for Project Server appears, as shown in the following figure: 

Figure 2.4: Tools Menu 

Following table enlists the options available in the Tools menu: 

Option Description 

Options… Select this option if you want to scan the entire database for possible corruption. 
This option is recommended to be selected while performing SQL database repair. 

Help Menu 

Help menu of Kernel for Project Server appears, as shown in the following figure: 

Figure 2.5: Help Menu 

The following table enlists the options available in the Help menu: 

Option Description 

Kernel for Project Server Help Opens the user manual of Kernel for Project Server 

Kernel for Project Server Homepage Opens the homepage of software website 

About Kernel for Project Server… Displays the version and support related information 
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2.3 Tool Bar 

The Tool bar is displayed just below the Menu bar section of the software interface and consists of buttons 
that work as shortcuts for various options available in the main menu of the software. The buttons assists 
users to easily perform the operations that can also be performed by Menu bar options. Following table 
enlists the buttons available on the Tool bar of Kernel for Project Server:  

Button Button Name Description 

Open Opens the Database Source Selection window 

Save Saves files, folders and database objects 

Help Opens user‟s help manual of the software. 

2.4 Status Bar 

The status bar is displayed at the bottom of the software window. The text „Ready‟ is displayed on the 

status bar if Kernel for Project Server is ready to be used. The status bar also displays the text „CAP‟, 

„NUM‟, „SCRL‟ which respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your 

keyboard. If any of these keys are pressed, the color of the corresponding text will turn blue/black. 

Figure 2.6: Status Bar 
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2.5 Left Panel 

The Left Panel of Kernel for Project Server displays recovered Project Server folders and their sub-folders 
in a hierarchical manner. The folders that are displayed at the left panel for Kernel for Project Server are: 

Tables 

Project 

Project Actual 

Figure 2.7: Left Panel 

 Note: If the recovery is done through Live SQL Instance, the left panel will display only Project 

and Project Actual folders. 

2.6 Right Panel 

The Right Panel of Kernel for Project Server displays the content of sub-folders. The file information is 
displayed alongwith details like File Name, File Type, Version, Last Modified Time, Creation Time and User 
name. 
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Figure 2.8: Right Panel 
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3. Install and Uninstall

3.1 Installing Kernel for Project Server 

After being familiar with the software overview, key features, and system requirements let us install Kernel 
for Project Server. The software is easy to install and involves few simple steps to configure it. However, 
before installing the software make sure that the software installer file is available on your computer. If the 

file is not available on your computer then you can download it from our Website: 

https://www.nucleustechnologies.com/kernel-project-server.html

After you have downloaded the installer file, execute the following steps to install the software: 

1. Double-click the Kernel for Project Server installer file.

2. Follow the on-screen instructions. When the installation process completes “Setup Installation

Complete” message appears on the software installation screen.

3. Click the Finish button to launch the software.

After you have completed the software installation process, a shortcut to start the software will be added 
in the Windows Start program menu. You can start the software from Windows Start program menu. You 
can also create desktop icon of the software from where you can start the software by double-clicking the 
icon. 

3.2 Uninstalling Kernel for Project Server 

Kernel for Project Server can be uninstalled from the computer system by using one of the following two 
methods: 

Uninstall from Windows Start Menu 
Uninstall from Control Panel 

 Note: Before starting the uninstallation process, make sure that the Kernel for Project Server 

is not in use. 

Uninstall from the Windows Start menu 

Execute the following steps to uninstall Kernel for Project Server from Windows Start menu: 

1. Click Start > All Programs > Kernel for Project Server > Uninstall Kernel for Project Server. A

warning message before uninstalling the software will be displayed on the screen.

2. Click Yes button to uninstall the software.

3. Click OK button.
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Kernel for Project Server is successfully uninstalled from your computer system. 

Uninstall from Control Panel 

Execute the following steps to uninstall Kernel for Project Server from Control Panel: 

1. Click Start > Control Panel. The Control Panel window appears.

2. Double-click the Add or Remove Programs icon. A list of the programs installed on your computer

system appears.

3. Select Kernel for Project Server and click the Remove button.  A warning message before

uninstalling the software will be displayed on the screen.

4. Click Yes button to uninstall the software.

5. Click OK button.

Kernel for Project Server is successfully uninstalled from your computer system. 
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4. Using Kernel for Project Server

4.1 Two Modes of Recovery 

Kernel for Project Server offers two modes for performing data recovery from corrupt Project Server MDF 
files: 

Raw File Mode 

Live SQL Instance Mode 

4.1.1  Raw File Mode 

The Raw File Mode of recovery is used where only the MDF database is corrupt and MS SQL Server and 

MS Project Server are in working condition. Some of the key features of Raw File Mode are as follows: 

This recovery mode is applicable in conditions where only database is corrupt. 

In this recovery mode, MDF database is repaired as an orphan file and files and folders are 

extracted from it. 

Use of Orphan database in Raw file mode eliminates the dependency of MS Project Server in 

recovery process. 

Raw File Mode recovers Tables, Project and Project Actual folders and allows user to view and 

save the files contained in these folders. 

In Raw file mode, tables can be recreated by connecting batch file to the SQL Server Database, 

once the tables are recreated the database is again ready to be configured in MS Project Server. 

4.1.2 Live SQL Instance Mode 

In cases, where MS Project Server is down or corrupt, Live SQL Instance recovery mode is used.  This 

recovery mode is embedded with distinct features, which make it suitable for specified corruption 

conditions. Some of the salient features of Live SQL Instance Mode are as follows:  

This recovery mode is applicable in conditions where MS Project Server is down.  

In Live SQL Instance recovery mode, documents are extracted from the database.  

Recovered documents can be again uploaded in a new account created on Project Server. 

UDL file connected to the SQL server can also be used for recovery. 
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4.2 Recovery through Available Modes 

4.2.1 Recovery through Raw File Mode 

Using Raw file mode, recovery process can be performed by following the steps as given below: 

Step 1: Click Open button from the tool bar or select Open from the file menu. 

 Note: When Kernel for Project Server is launched, the Source Selection window appears by 
default. You can also start the recovery process by selecting recovery mode from Source 

Selection Window. 

Step 2: A Source Selection window will appear. Select Raw File mode and then click Next button. 

Figure 4.1: Selecting Raw File Mode of Recovery 

Step 3: A new dialog box - Select Project Server Database will appear to select the database location. 
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Figure 4.2: Selecting Project Server Database 

Step 4: Click Browse button and select the location where the corrupt MDF database is stored. Now click 

Select Temp to select the location to save the temporary files which are generated by the software while 

performing various functions. 

Step 5: You can either let the software Auto Detect the database version or you can manually select the 

SQL file version. 

Step 6: Click Finish button after selecting the SQL Server version. The recovery process will start and a 

window showing the process status will appear. 

Figure 4.3: Displaying the recovery process status in Raw Mode 
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Step 7: Once the recovery process is complete all the recovered Tables, Project and Project Actual folders 

will get listed at the left panel of the software. 

Figure 4.4: Listing all the recovered data using Raw Mode 

4.2.2 Recovery through Live SQL Instance Mode 

In cases, where Project Server is down, Live SQL Instance Mode is used. To perform recovery through 

Live SQL Instance Mode, two options to connect with the database are available. These options are: 

Connecting Through MS SQL Server 

Connecting Through UDL File 

4.2.2.1 Connecting Through MS SQL Server 

To perform recovery by connecting with the database through MS SQL server, follow these simple steps: 

Step 1: Click Open button from the tool bar or select Open from the File menu. 
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Step 2: A new dialog box - Select the Database Source will appear. Select Live SQL Instance mode and 

then click Next button. 

Figure 4.5: Selecting Live SQL Instance mode of recovery 

Step 3: Database Location Selection window to select the database location will appear. Enter the server 

name and select Windows Authentication or SQL Server Authentication. 
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Figure 4.6: Selecting SQL Instance and Database 

Step 4: If you select SQL Server Authentication, you will need to provide the username and password of 

the working MS SQL Server whereas with Windows Authentication, Kernel for Project Server will 

automatically acquire the username and password of your system. Choose the appropriate option and type 

username and password accordingly. Enter the name of the Live SQL Database from which items 

needs to be recovered. 

Step 5: Click Finish. A window showing status of the scanning process will appear. 

Figure 4.7: Displaying the recovery process status in SQL Server 

Step 6: Once the recovery process is complete the recovered Project and Project Actual folders will get 

listed at the left panel of the software. 
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Figure 4.8: Displaying the recovered data in SQL Server 

4.2.2.2 Connecting Through UDL File 

Universal Data Link file (.udl) helps to specify connection information to a data provider on Windows 2000 

and later operating systems. Kernel for Project Server helps to achieve quick recovery of files by allowing 

to get connected to the MS SQL Server through UDL file and perform the recovery operation. 

For performing recovery by connecting with the database through UDL file, the following steps need to be 

performed: 

Step 1: For establishing connection with database from which files need to be recovered, enable Use UDL 

file for connection information option on Database Location Selection dialog box. 
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Figure 4.9: Selecting UDL File for connection Information 

Step 2: For connecting with the database with this option, you will need to create an UDL file. For creating 

UDL file follow these steps: 

Creating an UDL File  

Step 1- Create a New Text Document (.txt) at the desired location.  

Step 2- Rename the file to „test.udl‟.  

Step 3- Double-click the „test.udl‟. Data Link Properties dialog box will appear. 
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Figure 4.10: Data Link Properties Dialog Box 

Step 4- In Data Link Properties dialog box, click Provider tab. 
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Figure 4.11: Setting the Provider in Data Link Properties 

Step 5- Select the Provider that will be used to connect to your database. For example, if you need to 

check the availability of a Microsoft SQL database, you would need to select „Microsoft OLE DB Provider 

for SQL Server‟. 

Step 6- Select the appropriate option and click Next to continue to the Connection tab. The Connection 

tab will request authentication information which is used to access your database. 

Step 7- Select or enter the Server name and the username and password used to access the database. 
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Figure 4.12: Setting Data Link Properties 

 Note: You need to select the Allow saving password option for saving the password. If 

the password is not saved at the time of Data Link Properties configuration, the software 
fails to get connected with the database and a message regarding login failure appears on 

the Screen of Kernel for Project Server. 

Step 8- Click the Test Connection button to confirm the connection to the server and database using the 

provided information. 

Step 9- Open „test.udl‟ with notepad. The file will contain a line with your connection string, which will be 

similar to: 

Provider=SQLOLEDB.1; Password=YourPassword; Persist Security Info=True; User 

ID=YourUserID ;_Initial Catalog=YourDB; Data Source=YOUR_LOCAL_SERVER_NAME 
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Step 3: Once UDL file is created, select Use UDL file for connection and browse the UDL file. 

Step 4: Click Finish. The scanning process will start and a window showing the process status will appear. 

Figure 4.13: Displaying the recovery process status in UDL File 

Step 5: Once the recovery process is complete the recovered Project and Project Actual folders will get 

listed at the left panel of the software. 

Figure 4.14: Displaying the recovered data in UDL File 

4.3 Saving the Recovered Data 

With Kernel for Project Server recovered files can be saved very easily. Recovered files that are saved in 

any specified location are restored according to the mode used for performing recovery process. Since 
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Raw File and Live SQL Instance recovery modes are used in specific corruption conditions, post-saving 

procedures for making the recovered files accessible again, are different. However, processes for saving 

recovered files are same in both modes. To save recovered files, you need to follow these steps: 

Step 1: Go to the left panel and select folders you want to save 

Step 2: Click Save on tool bar 

Step 3: The Saving Mode dialog box appears to select the saving mode. 

Figure 4.15: Saving Mode for saving the recovered data 
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You can save the recovered objects in three different modes which are: 

Saving Mode Process 

SQL Server Using this option, the recovered objects can be saved on SQL Server directly, 
even if the Server is running. To save the data on SQL Server: 

Mention Server Name and Name of the database in Server Name and 

Database name fields respectively. Do not provide name of existing database 

in Database name field. Create a new database in SQL Server Management 

Studio and enter the name of new database in Database name field. 

However, existing database name can also be provided but in case of 

existing database restored objects will get merged with existing objects. 

Select the Authentication option with which you wish to access the SQL 

Server i.e. Windows Authentication or Server Authentication 

To access SQL Server with Server Authentication, you need to enter User Name 
and Password in the respective fields 

Batch File Using this option, you can save the batch file of the rebuilt MDF file on a desired 
location. To save the recovered data, you need to browse the location using the 
Browse button. The data so recovered is saved in separate script files at the 

desired location. Also, a script file (commit.bat) is also created that enables the 
user to easily copy the recovered objects to a new database created on Server. 
To copy recovered objects to new database: 

Go to SQL Server Management Studio 

Create a New Database 

Double click on commit.bat 

OR 

(Run->cmd ) Change the path to recovered folder ( cd PathName) 

Use following syntax: 

>commit.bat servername newcreateddatabase sqlserverusername
sqlserverpassword

Press Enter key and all tables will be copied to the new created database. 

Save 
Documents 

Using this option, you can save recovered documents to the desired location. 
Just select the desired location and click OK to save documents separately on 
your hard disk. 

 Note: Select or de-select the Save in full path checkbox. This option, if checked saves the 
recovered documents with complete hierarchy, but if un-checked, then the software only 

saves the respective folder with its contents. 
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Step 4: Click OK and the files will be saved in defined location. 

Figure 4.16: Saving Process Completion Window 

Process to Create New Database through Commit.bat file - Using Raw File Mode 

When using Raw File mode of recovery, Kernel for Project Server generates a Commit.bat file which 

contains the recovered tables from the corrupt MDF file. The Commit.bat file is then easily attached and 

connected to the MS SQL Server and items from recovered tables are restored to new database on the 

server. 

Go to SQL Server Management Studio 

Create a New Database 

Go to Command Prompt (Start menu->Run->cmd ) 

Change the path to recovered folder ( cd PathName ) 

Run the Commit.bat file by typing "commit.bat servername newcreateddatabase 

sqlserverusername sqlserverpassword" > press Enter key and all tables will be copied to the 

new created database. 

Once all tables are copied in database, the database is ready to be configured in MS Project 

Server. 
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 Note: This option is applicable when only the MDF database is corrupt and recovery is 
performed through Raw recovery mode. 

Process to create new database through recovered files - Using Live SQL Instance mode 

When Live SQL Instance mode is used for recovery, Project and Project Actual folders are generated. The 

folders contain all recovered files, which are further restored to a new account on MS Project Server. Once 

new account is created and configured on MS Project Server, all files that are recovered through Kernel for 

Project Server can be uploaded on that account. 

4.4 Create and Save Reports 

Kernel for Project Server generates a list of path location where the files are positioned: Project Folder 

Location and Project Actual Folder Location. With Kernel for Project Server, report of extracted files and 

documents are saved in HTML file. 

To create and save report, follow the steps given below: 

Step 1: At the bottom of the screen a window titled Document List is displayed. This list contains fields 

such as File Name, Project Folder Location and Project Actual Folder Location. To create and save report, 

click Project Folder Location of the file for which you want to create report. 

Figure 4.17: Depicting File Name, Project Folder Location and Project Actual Folder Location 
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 Note: Document List window also helps to filter or search for specific files and other items if you 

know the saving location of those files. Search and click the appropriate link and locate the files. 

Step 2: All files of that folder will get displayed at the right panel. 

Step 3: Click  Save in HTML option from document list window. 

 Note: To view and hide the Document List window, right-mouse-click the Toolbar and 

check or uncheck the Document List option. 

Figure 4.18: Selecting Document List Option 

Step 4: A dialog box to select the saving location will appear. Select the desired location and folder. 

Figure 4.19: Selecting the location and folder for saving recovered data 

Step 5: Click OK and the report will be saved in HTML file at the defined location. 
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5. Download, Purchase and Register

5.1 Free Trial Download 

The trial version of Kernel for Project Server is also available for free of cost, using which a user can 
evaluate and analyze the features, functionalities and capabilities of the software before making actual 
purchase. Free version of Kernel for Project Server works almost similar to that of the full version. Using 
the trial copy, user can preview the recovered files, folders and documents, but cannot save them. For 
saving the entire items, purchase the full version of the software. 

Free version of Kernel for Project Server can be downloaded from our safe and secure 

website: https://www.nucleustechnologies.com/kernel-project-server.html

5.2 Purchase & Register 

Purchase the Full version of Kernel for Project Server for saving the recovered documents.  The FREE 
trial version of Kernel for Project Server only displays preview of the recovered files and folders but limits 
from saving them. 

Purchase the Full version of Kernel for Project Server through our encrypted and secure Website: 

https://www.nucleustechnologies.com/buy-project-server-recovery.html

Payment and Delivery 

Purchase the Kernel for Project Server from our authorized resellers, which provide number of payment 
options for your ease - Paypal, FAX, Credit Card, E-cheque, Pay Order, etc. 

After making the purchase transaction with our resellers, an email is sent consisting of activation details 
and download link for the Full version of Kernel for Project Server comprising of the activation code. This 
email is sent to the email address, which you have used while processing the purchase transaction with 
our resellers. We suggest you not to use false email address while making the purchase transaction. 

For any other details related to purchase process, software activation process, email us at: 

sales@nucleustechnologies.com 

5.3 Support 

KernelApps Pvt Ltd provides round-the-clock technical support for its product range to solve technical
and software queries. The software comes with an embedded user help manual that can be accessed by 
clicking Help in the software main window. You can also press the F1 key on the keyboard of your 

computer to access the embedded user help manual of Kernel for Project Server. 

We also have live support wherein you can chat with our software experts at: 

https://www.nucleustechnologies.com/supportcenter/
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Telephone Support: 

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

Email Support: 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 
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6. Troubleshooting

6.1 Common Issues 

What is the limitation in trial version of Kernel for Project Server? 

The trial version of Kernel for Project Server works almost same as that of the full version of the software 
but has some limitation. Using the trial copy, user can preview the recovered files, folders and documents, 
but cannot save them. 

6.2 Frequently Asked Questions 

1. What are the major reasons for corruption of MS Project Server databases?

Major reasons for corruption of MS Project Server databases include server crash, drive failures, fault in 
saved database, accidental file deletion, etc. 

2. Give the link to purchase Kernel for Project Server?

One can purchase Kernel for Project Server using our safe, secure and encrypted Website: 

https://www.nucleustechnologies.com/buy-project-server-recovery.html

3. What are the two modes of recovery in Kernel for Project Server?

Kernel for Project Server offers two recovery modes- Raw File Mode and Live SQL Instance Mode. 

4. What are the supported Windows OS Platforms for Kernel for Project Server?

The supported Windows OS Platforms for Kernel for Project Server are Windows 2000, Windows Vista, 
Windows XP, Windows Server 2003, Windows Server 2003 - 64 Bits, Windows Server 2008 Enterprise, 
Windows Server 2008 Enterprise- 64 Bits, Windows 7 Ultimate and Windows 7 Ultimate- 64 Bits. 

5. What versions of MS SQL Servers does Kernel for Project Server support?

The supported MS SQL Server versions for Kernel for Project Server are MS SQL Server 2000, MS SQL 
Server 2005, MS SQL Server 2008, MS SQL Server 2008 R2, and MS SQL Server 2012. 

6. What versions of MS Project Servers does Kernel for Project Server support?

The supported MS Project Server versions for Kernel for Project Server are MS Project Server 2010, MS 
Project Server 2007, MS Project Server 2003, MS Project Server 2002, and MS Project Central (2000).  

7. Give the link for downloading the free trial version of Kernel for Project Server.

The free trial version of Kernel for Project Server can be downloaded using the 

link: https://www.nucleustechnologies.com/kernel-project-server.html
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7. Legal Notices

This section comprises the legal specification about Kernel for Project Server and the company 
KernelApps Private Limited.

7.1 Copyright Notice 

KernelApps Private Limited, Kernel for Project Server, accompanied user manual, and documentation
are copyright of KernelApps, with all rights reserved. Under the copyright laws, this user manual
cannot be reproduced in any form without the prior written permission of KernelApps. No Patent
Liability is assumed, however, with respect to the use of the information contained herein. 

© KernelApps PVT LTD. All rights reserved.

7.2 Trademarks 

Kernel for Project Server ® is a copyright work of KernelApps Private Limited.

Windows 7®, Windows Vista®, Windows XP®, Windows 2003®, Windows 2000®, Windows 98®, and 
Windows 95® are registered trademarks of Microsoft Corporation. All other brand and product names are 
trademarks or registered trademarks of their respective companies. 

7.3 Disclaimer 

The information contained in this user manual, including but not limited to any product specifications 
is subject to change without notice. KernelApps Private Limited provides no warranty with regard to this
user manual or any other information contained herein and hereby expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing. KernelApps Private Limited assumes no liability for any damages incurred directly or
indirectly from any technical or typographical errors or omissions contained herein or for 
discrepancies  between the product and the user manual. 

In no event shall KernelApps Private Limited be liable for any incidental, consequential special, or
exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with 
this user manual or any other information contained herein or the use thereof. 



© KernelApps P r i v a t e L i m i t e d

7.4 License Agreement 

Kernel for Project Server© by KernelApps Private Limited.

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing, or distributing this 
software, unless you have a different license agreement signed by KernelApps Private Limited. The
terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
Kernel for Project Server. For purposes of this License, if you have a valid license, you have the right to 
use a single Licensed Copy of KernelApps.

Scope of License 

Each Licensed Copy of Kernel for Project Server may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in the KernelApps, which are not expressly granted in this License, are entirely

and exclusively reserved to and by KernelApps. You may not rent, lease, modify, translate, reverse
engineer, decompile, disassemble, or create derivative works based on, KernelApps, nor permit anyone else to
do so. You may not make access to KernelApps available to others in connection with a service

bureau, application service provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Project Server, and any and all accompanying software, files, data and materials, are 
distributed and provided as is and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Kernel for Project Server, must be thoroughly 
tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all 
use of the copies of Kernel for Project Server covered by this License. This disclaimer of warranty 
constitutes an essential part of this License. In addition, in no event does KernelApps authorize you
or anyone else to use Kernel for Project Server in applications or systems where Kernel for Project Server 
failure to perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any 
such use is entirely at your own risk, and you agree to hold KernelApps harmless from any and all
claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements, and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third-party beneficiaries of any promises, 
obligations, or representations made by KernelApps herein. Any waiver by KernelApps of any
violation of this License by you shall not constitute, nor contribute to, a waiver by KernelApps of any
other or future violation of the same provision, or any other provision, of this License. 




